
Using Expression Web 
to Create Basic CSS

Now that you have a basic understanding of style properties and values, it is time to use
Expression Web to create your styles. Expression Web lets you specify which CSS specification
you want to use on your website. There are three separate CSS schemas: 1, 2, and 2.1. On 
the Authoring tab of the Page Editor Options dialog box, you left the default CSS schema at
CSS 2.1, which includes advanced positioning elements. In this chapter, you will focus on
CSS 1 formatting. For the exercises in this chapter, you will be alternating between the <h1>
and <body> elements using the structural.html page from Chapter 3. In the following chap-
ter, you will use more advanced CSS positioning with CSS 2.1.

Creating New Styles
You can create new styles in Expression Web in several ways, some of which you saw when you
explored the Format menu. Other options include the following:

• The Format toolbar: This is most useful for creating quick styles on the fly but is limited
to text and borders. This toolbar is open by default.

• The Styles toolbar: This is not on by default but is an unrecognized gem for quickly cre-
ating new styles and applying both classes and IDs to your page. Use View ➤ Toolbars
to launch this toolbar. I like to dock it at the bottom of Expression Web.

• The Apply Styles task pane: This displays not only any existing styles you might use but
also a link near the top to launch the New Style dialog box.

• The Manage Styles task pane: This also includes a link to launch the New Style dialog box.

The best way to learn how to create a style in Expression Web is to do so. Before you can
create styles in Expression Web, though, you must have a web page or stylesheet open. Since
you cannot use the tools in Expression Web to create or manage styles without a web page or
stylesheet open, all the examples and exercises in this section will use the structural.html
page from Chapter 4 unless otherwise stated. If you prefer, you can download a fresh copy of
the structural.html page at http://foundationofexpressionweb.com/exercises/chapter6/ or
download a zip file with all the Chapter 6 exercise files.
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You will be using the New Style dialog box to create your website styles, so launch the New
Style dialog box shown in Figure 6-1 using the New Style link in the Manage Styles or Apply
Styles task pane. You can also launch this dialog box from the Format ➤ New Style menu.

Figure 6-1. New Style dialog box

■Note The numbers in parentheses in this section refer to the numbers shown in Figure 6-1.

When you open the New Style dialog box, the Font category is the default, with the new
class .newStyle1 as the default in the Selector box (1). Use the drop-down arrow to expand the
box, and choose h1.

■Tip Styles created using the New Style dialog box will be newStyle1 and increment, while autogener-
ated styles created using the Format toolbar will use style1 and autoincrement.

You have the option to define the style in the current page, define a new stylesheet, 
or define an existing stylesheet depending on which choice you make in the “Define in”
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drop-down box (2). For now, leave the default setting of “Current page” to create a style block
in the <head> section of your page. If you select an external stylesheet from this drop-down
box, the URL text box will become available, and you will be able to use the Browse button (3)
to select the stylesheet.

The “Apply new style to document selection” option (4) applies the style created to the
highlighted section of the page document. Use this option if you are creating a custom class or
ID as your selector and you want to apply it to a highlighted section of your page.

If you want to use the same font family as the rest of the web page, you do not need to
specify a font in the font-family drop-down list (5). In this case, you want to use the same
font as the rest of your page, so don’t specify a font family here in order to take advantage of
inheritance.

The font-size drop-down list (6) offers a choice of CSS keywords from xx-small to xx-large
or the option to specify a number. When you specify a number, you must choose the unit of
measurement (7); all the available units of measurement are available in the secondary drop-
down list.

■Note As hinted at in Chapter 5, do not use pixels or points from the drop-down list since those units of
measurements do not resize in Internet Explorer using View ➤ Text Size. Inches, centimeters, and millime-
ters are measurements that do not translate to the Web. Use pixels for images, not text. Points, inches, and
metric measurements work best in print stylesheets. For screen display, limit your choices to keywords, em,
ex, and percent.

You can set the font-weight drop-down list (8) anywhere from 100 (light and thin) to 900
(heavy and bold), or you can set it to a keyword; 400 is normal, 200 is light, and 600 is bold.
Light is not well supported by browsers, and bold is the default for all header elements, so you
do not need to change font weight unless you want to make a heading normal weight instead
of bold. Experiment with the options of italic and oblique for the font-style drop-down list (9).
In most fonts, there will be no visual difference between italic and oblique. (The difference is
the direction of the slant.)

The font-variant drop-down list (10) offers small fonts as an optional text format. The
text-transform drop-down list (11) will change the case of your text to capitalize all letters, to
capitalize no letters (lowercase), or to capitalize the first letter of every word.

You must specify the color drop-down list (12) in one of three ways: hex, RGB (red, green,
blue), or a named color. As you saw in Chapter 5, hex is the preferred choice by web designers,
though many who have migrated from print to the Web continue to use RGB. Named colors
are not always interpreted the same from one browser to another but are generally close.
There might be more color variations between the calibrations of different monitors than
between different browsers.

The most commonly used text-decoration setting (13) is none (13e), which removes the
default underline from hyperlinks when other styling choices fit in better with the design and
make it clear that the item is a link even without underlining. Underline (13a) should be used
only with links or to indicate additional information when the mouse is over the element in
the form of a title attribute value. Overline (13b) is rarely used, while line-through (13c)
should be used in limited circumstances usually to indicate editing. Blink (13d) is a nod to 
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the Netscape 4 element <blink>. I can think of no good reason to use blink because blinking
text and images are annoying, they mark the creator as an amateur, and they have poor
browser support.

■Note Underline is the default for links, so using an underline in any other context will make visitors think
it is a link and that the link is broken when they attempt to use it.

The Preview section (14) allows you to see the effect of your style choices, while the code
for the styles appears in the Description (15) section. Pay attention to the code written here
since it will help you learn proper CSS syntax.

Click the OK button, and view your page.
Exercise 6-1 shows how to select a font category.

Exercise 6-1. Selecting a Font Category

In this exercise, you’ll set the font size for the first-level headings.

1. With the structural.html file open, begin by launching the New Style dialog box. From the Selector
drop-down list, choose h1, as shown in Figure 6-2.

Figure 6-2. The Selector drop-down lists all available HTML elements.
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2. Next, set the font size as shown in Figure 6-3, and use the drop-down list to select ems for the unit of
measurement from the font-size drop-down list.

Figure 6-3. Remember, for your fonts to scale in all browsers, you need to use em, percent,
or a keyword.

3. Finally, save your file.

You will be returning to this file in the next exercise, and after that, you’ll use the color picker to select the color in
the background.

Using the Block Category
Although Expression Web uses the term “block” for the next set of options, the options here
are not what are usually considered to be block definitions in CSS.

As used in CSS, a block element is one that holds other elements. There is margin or
padding around all block-level elements by default. If the element does not hold other items,
as is the case with a line break such as <br /> or a <span>, it is inline. In Figure 6-4, you see the
CSS properties Expression Web has under the Block category, not all of which are traditional
CSS block properties.
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Figure 6-4. The Block category

This section of the New Style dialog box refers to inline elements such as the following
(the numbers relate to Figure 6-4):

1. line-height: Line height allows you to determine how much space you want to have
between the lines of text. The default line spacing is approximately 1.2 times the height
of the text. You can change the line height to create double-spaced text or any other
line spacing of your choice. You cannot have a negative value for line height.

■Caution Reducing line space makes the text harder to read, so be careful if you decide to use less than
the default line spacing, or your text might have the ascenders and descenders cut off or overlapping.

2. vertical-align: In theory, this should adjust the position of the text within the line
height, but for most browsers the only time the vertical-align setting works properly 
is inside a table cell. Sub and super are usually supported. Testing is always required
when you use the vertical-align drop-down list.

3. text-align: Left, right, centered, justified, or inherit are your only options. Justified
should be used sparingly, if at all, since web browsers cannot use kerning to adjust 
letter spacing, which means spaces are added between words; the effect can be very
unattractive.
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4. text-indent: This will affect only the first line of text in a multiline paragraph or other
HTML element. Not all browsers support the text-indent setting properly.

5. white-space: The HTML default means no matter how many spaces you have in your
HTML code, only one space will be rendered in the browser. You can use either the
HTML element <pre> or CSS to change whether additional spaces or line breaks in
your code will display in the browser. The white-space: pre attribute is widely sup-
ported by browsers, which will cause the text to display with the same spaces as are 
in Code view, including multiple spaces and line wraps. Most modern browsers will
honor white-space: nowrap, but it might not be honored by all.

6. word-space: This adjusts the whitespace between words.

7. letter-space: This spreads out the letters within a word.

Exercise 6-2 shows how you’ll use the Block category in the New Style dialog box.

Exercise 6-2. Using the Block Category

In this exercise, you’ll center your <h1> in your structural.html page.

1. With the <h1> in your structural.html page selected from the Apply Styles task pane, right-click, and
select Modify Style, as shown in Figure 6-5.

Figure 6-5. You can right-click any style in the Apply Styles or Modify Styles task pane to edit
your styles.
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2. This will launch the Modify Style dialog box. The only difference between this dialog box and the New Style
dialog box is the title. Select Category ➤ Block, and use the text-align drop-down list to select the center
option, as shown in Figure 6-6.

Figure 6-6. You can use the text-align drop-down list to center inline content such as text
and images.

3. Click the OK button, and save your file before moving to the next section.

Setting the Background
Many of the options available in the Background category are more appropriate for the <body>
element, classes, or IDs, as shown in Figure 6-7.

Figure 6-7. Backgrounds can be put on any selector.

Let’s look through all the options (the numbers relate to Figure 6-7):
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1. background-color: Expression Web uses the standard Windows color picker, but if you
know the hex code for the color you want to use, you can type it, such #ECF0FB, as
shown in Figure 6-8.

Figure 6-8. Expression Web uses the same color picker as most Windows applications.

2. background-image: By default the background image you choose will scroll with your
page, but you have the option to make the background fixed and have the page scroll
over it. This gives a watermark effect that was very trendy in 1999 but can still be used
effectively in some cases.

3. background-repeat: The default is for a background image to repeat both horizontally
and vertically. With this option, you can change that so it repeats horizontally (repeat-
x) or vertically (repeat-y) only. You also have the option to use the background image
only once on the page by selecting the norepeat option.

4. (x) background-position: Background position must either use a keyword or be set in
pixels; x is the horizontal position from the left side of the browser window.

5. (y) background-position: This uses the same settings as option 4, but y sets the vertical
position from the top of the browser.

Exercise 6-3 shows how to set your background and fonts for your entire web page.

Exercise 6-3. Setting Background Properties

Before you begin this exercise, you should download the /crystal-bg.jpg image from http://
foundationsofexpressionewb/exercises/chapter6 and import it into your practice site’s image folder.
Figure 6-9 shows the crystal-bg.jpg file.

Figure 6-9. The crystal-bg.jpg image
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1. With your structural.html page open, launch the New Style dialog box again. Select body from the
Selector drop-down list. Before you move to the Background category, set the font to the “Tahoma, Helvetica,
Arial, sans-serif” font family group created in Chapter 3 from the font-family drop-down list (see Figure 6-10).

Figure 6-10. Select the font family you created in Chapter 3 in the Font Families tab of the
Page Editor Options.

2. Make sure you set a text color; in this exercise, select black or #000000 for your font color since you know
that black will provide sufficient contrast with the crystal-bg.jpg image.

3. Select Background from the Category list, and use the Browse button to select the crystal-bg.jpg file
you downloaded (or another image of your choice).

4. You should see the crystal-bg.jpg image appear in the Preview box. It is important to select the back-
ground image before the next step because you’ll match your background color to the primary color in the
image. That way there will be sufficient contrast with the text that will go on top of the image.

5. To choose your background color from the background-color drop-down list, use the More Colors option to
open a color picker with the 256-safe color palette. Click the Select button with the eyedropper on it to pick
a background color from the Preview box, as shown in Figure 6-11.

■Note Before you launch the eyedropper, you might need to move the More Colors box to reveal the
Preview section.

6. Select and apply the remaining background-options as follows:

• background-repeat: no-repeat

• background-attachment: fixed

• (x)background-position: center

• (y)background-position: center
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Figure 6-11. Use the eyedropper to choose the predominant color in your image.

7. Your background selections should match Figure 6-12.

Figure 6-12. The Description box includes all the CSS properties that have been selected 
for the body in the completed exercises.
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8. If you chose a different image, make sure you choose a color that will have a strong contrast with the back-
ground color and image you used. Save your file, and be sure you preview it in your browser at a couple of
different resolutions.

Creating a Border
Now you’ll return to the h1 selector to learn how to set border properties. Since you have
already defined a style for the <h1> element, you will need to modify the current style defini-
tion. Earlier you selected Modify Styles from the Apply Styles task pane with the <h1> element
selected. This time use the Manage Styles task pane where all the styles you have created
appear, as shown in Figure 6-13.

Figure 6-13. You can select any style shown in the Manage Styles task pane to modify, even if it is
not selected in Design view.

Once the Modify Style dialog box launches, select Border from the Category section. You
will see three border options each with a check box between the border property and the top
drop-down list (see Figure 6-14). This option is checked by default because Expression Web
assumes that you want to make the border the same on all four sides by default.

If you want to set a separate border style for each side or use a border on less than all four
sides, simply remove the check mark from the “Same for all” box.
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Figure 6-14. The Modify Style and New Style dialog boxes are the same except for their titles.

Let’s look at all the options (the numbers relate to Figure 6-14):

1. border-style: This determines the type of border line the browser will display. Although
solid is the most commonly used, you have other options such as dotted, dashed, 
double, ridge, inset, and outset. In Internet Explorer 6 and below, there might be no
noticeable difference between dotted and dashed. Make sure you preview your border
style in a variety of browsers since styles other than solid might not render the same
across browsers.

2. border-width: You have three named options for how thick your border will be (thin,
medium, and thick), or you can set a specific width. This is one place where I recom-
mend using pixels unless you want the thickness of your border to increase with the
font size.

3. border-color: Use this section to set the color of your border.

4. top, right, bottom, and left: Once you uncheck the “Same for all” box, you will have the
option to set the value for each side in the boxes to the right.

Exercise 6-4 shows how to set the border properties.
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Exercise 6-4. Setting Borders

In this exercise, you’ll learn how to set basic box borders as well use borders for a picture frame effect.

1. Leave the checks in the “Same for all” boxes checked, and select solid, thin, and a color for your h1, as
shown in Figure 6-15.

Figure 6-15. Simple borders using the same setting for each side

2. Previewing the page in Internet Explorer 7, the basic borders look like Figure 6-16.

Figure 6-16. Basic border on <h1>

3. Experiment with some of the other border styles without changing the border width. Make sure you save
your changes and preview them in at least the two most common browsers, Internet Explorer and Firefox.

4. Next, change the width, and try the different browser views again. Pay attention to the differences.

Setting Borders Like a Picture Frame

Next, you’ll set your borders to be a frame.

1. Change your settings to match those shown in Figure 6-17, and preview the page again.

2. Make sure that after you click OK, you preview the page in your browsers.

3. Optional: download the h1-bg.png image from http://foundationsofexpressionweb.com/
exercises/chapter6, and import it into your local site. Use the Background category to set it as the
background for your image. Figure 6-18 shows the final page.
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Figure 6-17. Using a combination of inset and outset border values can give you a frame effect.

Figure 6-18. The image used is a PNG with transparency, which will allow the background to
show through in Internet Explorer 7, Firefox, Opera, and Safari.

You’ll learn more about transparent images and their limitations in Chapter 8.

■Tip The only reliable method to get a vertical line is to use a left or right border, and although there is an
HTML element called a horizontal rule <hr />, it can be difficult to style it so that Firefox, Internet Explorer,
Opera, and Safari all display the line with the same characteristics. Using just a top or bottom border for a
horizontal line is often a better choice.
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Although I have concentrated on the WYSIWYG method of creating and modifying styles,
you can use two other methods. The first uses the CSS Properties task pane, and the second
uses IntelliSense.

If you have been writing your own CSS or simply prefer to see all the options available in
one window, use the CSS Properties task pane, where you can, with the element selected, add,
remove, or change your CSS directly. By default, the CSS Properties task pane is grouped with
Tag Properties for HTML elements, as shown in Figure 6-19.

Figure 6-19. You can sort the CSS Properties task pane in different ways, but it is much easier to
know which properties are defined when you have the properties that you’ve used at the top of
the list.

The CSS Properties task pane is divided into two sections. The top section shows you the
styles that are applied to the element or class selected, and the lower section shows you all the
properties available that are not applied. In Figure 6-19, the h1 was selected, and you can see
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the styles applied to the h1. Once in the CSS Properties task pane, if you select an element
higher up on the list, such as the body element shown in Figure 6-20, you will be able to see
how inheritance and the cascade applies when the browser displays the page.

Figure 6-20. Selecting the styles higher up in the Applied Rules section shows you what definitions
were applied.

Creating a Box
When you hear the term “box properties,” it generally refers to a subset of the properties of
block-level elements. The relevant properties are margin, padding, and border; how different
browsers interpret these three properties is called the box model.

Box model issues arise because not all browsers use the same box model. The two models
are as follows:

• Additive: Where the size specified is only the content width. Padding, borders, and
margin are added to the specified width to obtain the size of the actual box the content
occupies on the page.

• Subtractive: This is where the width is the size of the frame or where the border is
applied and the content is the specified size minus any padding applied. The entire box
is the specified width plus any margins, default or explicitly stated.

The Box category in the New Style or Modify Style dialog box refers only to the padding
and margin properties. As with the border properties, you can choose to set all four sides to
the same setting or set them individually. Expression Web shows an illustration in the Box
section to provide you with guidance as to what the margin, border, and padding will look
like Figure 6-21.
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Figure 6-21. The Box category provides you with guidance on margin and padding.

Exercise 6-5 shows how to set box properties.

Exercise 6-5. Setting Box Properties

In Exercise 6-4, you used center for the text-align drop-down list to move the <h1> from the side borders you 
created. In this exercise, you’ll use padding to add space between the <h1> and the borders.

1. Remove center from the text-align drop-down list for the Block category. Preview your page, and you should
see Figure 6-22.

Figure 6-22. Without padding, the <h1> will almost touch the borders.

2. This is not very attractive. Add 1em of padding to your h1 style definition using the “Same for all” check box
in the Box category, and your heading will look much better as in Figure 6-23.
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Figure 6-23. One em of padding might be more than you would like on a heading element.

3. Experiment with less than 1em; try .5em (point five), and preview it. Try using 10px and other pixel and em
measurements.

4. Save your file with the name border2.html. You will be reusing this file in the Chapter 7 exercises.

When you add margins and padding through the style dialog boxes, then view the result in
your browser or in Design view because the result might not be what you expected. Rather than
reopening the Modify Style dialog box or randomly entering values in the CSS Properties task
pane, you can change the margin and padding in Design view, as explained in Exercise 6-6.

Exercise 6-6. Setting Margin and Padding in Design View

Before you begin, make sure you have the Margins and Padding visual aids turned on, as shown in Figure 6-24.

Figure 6-24. Visual aids make working in Design view easier.

1. Select your <h1> in the structural.html page in Design view. With the Margins and Padding visual aids
enabled, you will see light blue between the <h1> text and the border. This represents the 1em of padding
you have defined for your <h1>. The pink you see outside the border represents the <h1> default margin.
To make these easier to view in Figure 6-25, l have turned off the page and <h1> background color and
images by commenting those lines out in the code.
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■Caution If you drag using one of the circles shown in Figure 6-25, you will change the height, width, or
both of the <h1> element, not the margin or padding.

Figure 6-25. Visual aids help you determine which property needs to be modified.

2. Change the padding around your <h1> by holding the Shift key while you click, and drag anywhere on the
blue lines of the bounding box, except where you see the round circles. Your cursor will change to a double-
headed arrow, and you can drag padding for that side to the size of your choice. In Figure 6-26, you can see
an example of resizing the bottom padding.

Figure 6-26. Expression Web will use the same unit of measurement you specified in your h1
style when you resize in Design view.

3. Did you notice that this method does not add the changes to your h1 style definition but creates a new style
and applies it to your <h1> element? To change the margin, drag the pink handles that reside in each corner
of the bounding box (which are faint and might be hard to see), as shown in Figure 6-27.

Figure 6-27. The pink handles are for resizing the margins.

The changes you made to the margin are added to the style class created when you modified the margin.
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Up to this point, you have been following the category order used by Expression Web in the
New Style and Modify Style dialog boxes. The next two categories listed relate directly to page
layout, while lists are commonly used for site navigation using pseudo-classes for interactive
effects such as rollovers. In Chapter 7, you will be using these three properties to provide your
web page’s final presentation layer. That leaves the Table category for this chapter.

Creating Tables
In Chapter 4 you created a table by converting comma-separated data into a table. At that
time, you were not concerned about styling the table you created, so instead you added struc-
ture with table headers. In addition to creating a table from content you already have in a
comma-separated list, you can add an empty table using the Table ➤ Insert Table menu.

If you insert a table from the menu, you will see the New Table dialog box. As with the
New Style and Modify Style dialog boxes, the only difference between the Insert Table dialog
box and the Table Properties dialog box is the title. Figure 6-28 shows the Table Properties box
for the table you created in Chapter 4.

Figure 6-28. Table Properties tells you the number or rows and columns as well as any attributes
and some properties that might be applied.
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In this case, the table is devoid of any extra style. Cell padding and cell spacing are HTML
attributes that should remain as HTML attributes since there is no precise CSS equivalent for
cell spacing that is reliable in every browser. Expression Web knows this and will add cell spac-
ing and cell padding to your <table> element. Other table properties, height, width, borders,
and background, will be created as a style.

The options you select here in the Borders and Background areas will apply only to the
table itself with the exception of the “Collapse table border” setting, which means that where
two borders meet, such as the border for a table cell and the table border, only one border
(instead of separate borders for the table and the cell) will be displayed. If you have a table
style that you prefer as your default, once you have set the options for that style, you can save
it as your default. I’ll cover layout tools later in this chapter.

The style options available in the New Table or Table Properties dialog box are limited
compared to the properties available when you use the style-related dialog boxes. In the New
Style dialog box, use the Selector drop-down list to choose table, as shown in Figure 6-29. You
do not need to select the “Apply new style to document selection” check box unless you are
creating a custom style for your table where you would have typed in a class name instead of
choosing table from the drop-down list.

Figure 6-29. To create a default table style for this page or website, choose table as your selector.

In addition to the usual Font, Block, Background, Border, Box, Position, Layout, and List
category options, there is a category called Table, as shown in Figure 6-30.
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Figure 6-30. CSS table properties in the Table category are not available on the Table Properties
dialog box with the exception of border-collapse.

You will rarely use the table-layout drop-down list since the default when you set a table
width is to distribute extra space across all columns if the contents are not enough to maintain
the table width specified. The border-spacing drop-down list is an attempt to replace the
HTML attribute of cellspacing but is poorly supported. You might want to experiment with
empty cells since the default is to not render cells that have no content. This is why most empty
cells have a nonbreaking space (&nbsp;) inside them; the cell borders would not display other-
wise. The caption-side drop-down list will place the content of the <caption> element at the
bottom instead of above the table, which is the default.

By default, vertical alignment in table cells is set to middle. To change the vertical align-
ment, you would use the vertical-align setting in the Block category.

You might have noticed the check box to enable layout tools in Figure 6-28. Selecting this
check box will add comment tags to your table and allow you to use the Layout Tables task
pane where you can draw table cells to create a page layout, as shown in Figure 6-31.

Figure 6-31. Using Layout Tools allows you to manipulate tables used to position nontabular 
content in Design view.
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Using layout tables is no longer recommended, but if you are working on a legacy website
that uses tables, such as one created with FrontPage 2003, you can use these tools to manipu-
late them. Expression Web offers you a choice of CSS-based layouts under the Page tab of the
New dialog box, as shown in Figure 6-32. These are a better option for creating page layouts
when you are not upgrading a legacy website.

Figure 6-32. CSS-based layouts are a better option for new web pages and websites than using
table layouts.

As you can see, no table-based layouts are included with Expression Web. This is because
using tables for page layout is passé and should be used sparingly, if at all.

Summary
In this chapter, your web page is starting to look like something you would want your visitors
to see when they visit your site. You have focused on the CSS properties and values that are
used on every page but have stayed with the normal flow of your HTML source for page dis-
play. I touched briefly on using tables for layout and covered the better alternatives available
in Expression Web.

In the following chapter, you will remove some of the content from your page so that it no
longer appears in the normal document flow. You will create a basic two-column page layout
with a header and footer using CSS so that you can see how CSS layouts work.
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